
Data entry questions
1. Which option is used to undo the last entry in a cell in Microsoft Excel?

A) Ctrl + Z
B) Ctrl + Y
C) Ctrl + U
D) Ctrl + A

Answer: A) Ctrl + Z

2. Excel displays a green triangle in the corner of a cell. What does this
symbol typically indicate?

A. The cell contains a formula

B. The cell formatting is incorrect

C. The cell value is an error

D. The cell is linked to another worksheet

Answer: C. The cell value is an error

3. What is a common data entry technique used to minimize errors?

(a) Skipping breaks

(b) Double-keying data

(c) Multitasking

(d) Rushing through entries

Answer: (b) Double-keying data

4. Which tool is commonly used for data entry?

A) Adobe Photoshop

B) Microsoft Excel

C) AutoCAD

D) Adobe Premiere

Correct Answer: B) Microsoft Excel



5. You need to align text in a cell to the right side. Which formatting option
can you use to achieve this?

(a) Center Align

(b) Left Align

(c) Right Align

(d) Wrap Text

Answer: (c) Right Align

6. What is the first step in organizing data within a spreadsheet?

A) Applying cell borders

B) Sorting data

C) Entering data

D) Formatting text size

Correct Answer: C) Entering data

7. Which option should you use to make a title readable across multiple
columns in Excel?

A) Wrap Text

B) Merge & Center

C) Increase Font Size

D) All of the above

Correct Answer: B) Merge & Center

8. What does the formula =A1*B1 represent in Microsoft Excel?

A) Subtraction
B) Division
C) Multiplication
D) Addition

Answer:
C) Multiplication



9. Which formula is used to add the values in cells A1 and B1 in Microsoft
Excel?

A) =SUM(A1, B1)
B) =ADD(A1, B1)
C) =A1 + B1
D) =TOTAL(A1, B1)

Answer:
C) =A1 + B1

10.What is the correct file format for a comma-separated values file?

A) .xls
B) .csv
C) .txt
D) .xlsx

Answer: B) .csv

10. Which of the following is NOT a common method of data entry?

A) Manual data entry
B) Batch processing
C) Real-time data entry
D) Data mining

Answer: D) Data mining

11.What is the process of verifying and correcting data to ensure accuracy?

A) Data validation
B) Data visualization
C) Data transformation
D) Data mining

Answer: A) Data validation

12.What does a histogram represent?

a) Trends over time

b) Comparison of individual categories

c) Frequency distribution of continuous data



d) Relationship between two variables

Answer: c) Frequency distribution of continuous data

13.What type of chart would you use to compare individual categories to the
whole?

a) Line chart

b) Bar chart

c) Pie chart

d) Histogram

Answer: c) Pie chart

14.What type of data is best represented using a bubble chart?

a) Categorical data

b) Continuous data

c) Hierarchical data

d) Time series data

Answer: b) Continuous data

15.Which of the following is NOT a condition for conditional formatting?

A) Value is greater than

B) Value is less than

C) Cell color is blue

D) Text contains

Answer: C) Cell color is blue

16.Which option allows you to format cells that are above average?

A) Greater than

B) Less than

C) Above average



D) Below average

Answer: C) Above average

17.Can conditional formatting be applied to non-contiguous cells?

A) Yes

B) No

C) Both

D) None of the above.

Answer: A) Yes

18.What does the 'autocomplete' feature assist with during data entry?

A) Automatically correcting errors

B) Automatically completing repetitive data

C) Increasing typing speed

D) Deleting entered data

Answer: B) Automatically completing repetitive data

19.How can keyboard shortcuts improve data entry efficiency?

A) They slow down the process

B) They require memorization

C) They reduce the need for mouse movements

D) They are only applicable for specific software

Answer: C) They reduce the need for mouse movements

20.What is data entry?

A. Data processing

B. The process of inputting data into a computer system

C. Data analysis

D. Data storage



Answer: B) The process of inputting data into a computer system

21.How can you ensure data consistency (e.g., dates, formats)?

A. Rely on software auto-correction.

B. Follow pre-defined formatting guidelines.

C. Use different formats for each entry.

D. Skip formatting checks for faster entry.

Answer: B. Follow pre-defined formatting guidelines.

22.Which setting adjusts the amount of space between the edge of the page
and the content?

A) Orientation

B) Margin

C) Scale

D) Alignment

Answer: B) Margin

23.What does "Collate" mean in printing options?

A) Print in grayscale

B) Print multiple copies of the same page

C) Sort printed pages

D) Print on both sides

Answer: C) Sort printed pages

24.What is the standard resolution for printing high-quality images?

A) 72 DPI

B) 300 DPI

C) 600 DPI

D) 1200 DPI



Answer: B) 300 DPI

25.What is the purpose of using the "Print to File" option?

A) Print directly from a file

B) Save the document as a print file

C) Print using a network printer

D) None of the above

Answer: B) Save the document as a print file

26.What is the maximum number of worksheets you can add to an Excel
workbook by default?

A) 100

B) 200

C) 255

D) 512
Answer: C) 255

27.How can you customize the appearance of sheet tabs?

A) Right-click a tab and choose "Tab Color"

B) Format > Tab Color

C) Both A and B

D) Neither A nor B
Answer: C) Both A and B

28.What does CSV stand for?

A) Character Separated Values

B) Comma Separated Values

C) Computer System Values

D) Centralized System Values
Answer: B) Comma Separated Values



29.Which file format is used for exporting an Excel worksheet to be opened in
another program like Word?

A) .xlsx

B) .pdf

C) .txt

D) .docx
Answer: D) .docx

30.Which option allows you to export an Excel worksheet as a PDF file?

A) File > Save As > PDF

B) Data > Export > PDF

C) Home > PDF

D) Review > PDF
Answer: A) File > Save As > PDF

31.What does the INDEX function do?

A. Returns the value of a cell in a specific row and column

B. Returns the row number of a value in a range

C. Returns the column number of a value in a range

D. Returns the count of cells in a range

Answer: A. Returns the value of a cell in a specific row and column

32.Which function can be used to return a value based on multiple
conditions?

a) IF()
b) AND()
c) OR()
d) VLOOKUP()

Answer: a) IF()

33.What does the HLOOKUP function do?



A) Searches for a value in the first column of a table and returns a value in the same
row from a specified column.

B) Searches for a value in the first row of a table and returns a value in the same
column from a specified row.

C) Searches for a value in a specified range and returns a value in the same cell.

D) Searches for a value in a table and returns the corresponding value from the same
row in a specified column.

Answer: B) Searches for a value in the first row of a table and returns a value in the
same column from a specified row.

34.What does the CONCATENATE function do?

A) Splits text into separate cells.

B) Combines multiple text strings into one.

C) Rounds a number to a specified number of digits.

D) Counts the number of cells in a range.

Answer: B) Combines multiple text strings into one.

35.What does the AND function do?

A) Check if any condition is true.

B) Check if all conditions are true.

C) Check if no conditions are true.

D) Combines text from multiple cells.

Answer: B) Check if all conditions are true.

36. 8. Which function is used to round a number to a specified number of digits?

A) ROUNDUP

B) ROUNDDOWN

C) ROUND

D) AVERAGE

Answer: C) ROUND



37.What does the TRIM function do?

A) Removes leading and trailing spaces from text.

B) Multiplies values in a range.

C) Divides values in a range.

D) Converts text to uppercase.

Answer: A) Removes leading and trailing spaces from text.

38.Which security measure involves converting data into a code to prevent
unauthorized access?

A) Data validation

B) Data backup

C) Data encryption

D) Data masking

Answer: C) Data encryption

39.What is the primary objective of data protection laws and regulations?

A) Data encryption

B) Data validation

C) Data privacy and security

D) Data visualization

Answer: C) Data privacy and security

40.What is the primary purpose of data backup?

A) Data validation

B) Data encryption

C) Data recovery

D) Data masking

Answer: C) Data recovery



41.What is data validation primarily concerned with?

A) Data encryption

B) Data accuracy and integrity

C) Data storage

D) Data visualization

Answer: B) Data accuracy and integrity

42.What does GDPR stand for?

A) Global Data Privacy Regulation

B) General Data Protection Regulation

C) General Data Privacy Rule

D) Global Data Protection Rule

Answer: B) General Data Protection Regulation

43.Which function removes spaces from the beginning and end of a text
string?

A) TRIM

B) CLEAN

C) SUBSTITUTE

D) TEXTJOIN

Answer: A) TRIM

44.Which function is used to combine multiple text strings into a single
string?

a. A) CONCATENATE

b. B) UPPER

c. C) LEFT

d. D) TRIM

Answer: A) CONCATENATE



45.Which function calculates the difference between two dates?

A) DATEADD

B) DATEDIFF

C) DATEVALUE

D) TEXT

Answer: B) DATEDIFF

46.Which Excel tool can be used to create a pivot table?

A) Data Validation

B) Conditional Formatting

C) PivotTable Wizard

D) Goal Seek

Answer: C) PivotTable Wizard

47.Which option lets you sort data in descending order in a pivot table?

A) Sort Smallest to Largest

B) Sort A to Z

C) Sort Largest to Smallest

D) Sort Z to A

Answer: C) Sort Largest to Smallest

48.What does the 'Slicer' tool allow you to do in a pivot table?

A) Change the table layout

B) Create charts

C) Filter data visually

D) Add new data fields

Answer: C) Filter data visually

49.Which of the following is NOT a type of pivot table calculation?



A) Sum

B) Count

C) Average

D) Multiplication

Answer: D) Multiplication

50.Which of the following data sources can Power Query connect to?

a) Only Excel files

b) Only SQL databases

c) Excel files, databases, websites, and more

d) Only CSV files

Answer: c) Excel files, databases, websites, and more

51.What does M in M-code stand for in Power Query?

a) Merge

b) Manipulation

c) Microsoft

d) Metadata

Answer: b) Manipulation

52.What is the shortcut to launch Power Query in Excel?

a) Alt + F

b) Ctrl + Q

c) Alt + Q

d) Ctrl + Shift + Q

Answer: c) Alt + Q

53.What type of chart is best for showing the relationship between two
continuous variables?



A) Pie chart

B) Scatter plot

C) Bar chart

● D) Line chart

Answer: B) Scatter plot

54.Which color scheme is generally recommended for qualitative data?

A) Diverging

B) Sequential

C) Qualitative

D) Categorical

Answer: D) Categorical

55.Which chart is best for comparing multiple categories?

A) Pie chart

B) Histogram

C) Bar chart

D) Line chart

Answer: C) Bar chart

56.What does the COUNT function do in Excel?

A) Calculates the total

B) Find the maximum value

C) Counts the number of cells that contain numbers

D) Checks if a condition is met

Answer: C) Counts the number of cells that contain numbers

57.What is the result of the formula =ROUND(15.67, 1)?

A) 16



B) 15.7

C) 15

D) 16.0

Answer: B) 15.7

58.What does the VLOOKUP function do?

A) Finds the smallest value in a range

B) Searches for a value in the first column of a table array and returns a value in the
same row from another column

C) Calculates the average of a range of cells

D) Checks if a condition is met

Answer: B) Searches for a value in the first column of a table array and returns a value
in the same row from another column

59.What does the SUMIF function do?

A) Calculates the sum of cells that meet multiple criteria

B) Checks if a condition is met

C) Searches for a value in the first column of a table array and returns a value in the
same row from another column

D) Calculates the sum of cells that meet a single criteria

Answer: D) Calculates the sum of cells that meet a single criteria

60.Which tool allows you to automate repetitive filtering tasks?

a) PivotTable

b) Macro

c) Formula

d) Validation rule

Answer: b) Macro

61.What does the 'OR' operator do in a filter with two conditions?



a) Includes records that match both conditions

b) Excludes records that match either condition

c) Combines multiple conditions using 'AND'

d) Combines multiple conditions using 'NOT'

Answer: a) Includes records that match both conditions

62.What does XML stand for?

A) Extensible Markup Language

B) eXtended Multi-Language

C) Extra Markup Language

D) Extended Markup Logic

Answer: A) Extensible Markup Language

63.What does ETL stand for in the context of data processing?

A) Edit, Transform, Load

B) Extract, Transform, Load

C) Export, Transform, Load

D) Encrypt, Transform, Load

Answer: B) Extract, Transform, Load

64.Which technique involves checking data for errors, inconsistencies, and
duplicates?

A) Data validation

B) Data transformation

C) Data normalization

D) Data encryption

Answer: A) Data validation

65.What does a date filter allow you to do?



A) Filter by month

B) Filter by year

C) Filter by specific date range

D) All of the above

Answer: D) All of the above

66.What should you maintain while filtering and sorting data?

A) Data integrity

B) Data encryption

C) Data duplication

D) Data compression

Answer: A) Data integrity

67.Which database language is commonly used for importing/exporting data
from relational databases?

A) Java

B) Python

C) SQL

D) HTML

Answer: C) SQL

68.Which data format is commonly used for web services to transfer data?

A) CSV

B) XML

C) Excel

D) JSON

Answer: D) JSON

69.Which method involves transferring data between web services?



A) File Import

B) Data Migration

C) API Integration

D) Manual Data Entry

Answer: C) API Integration

70.Which method involves transferring data between databases?

A) File Import

B) Data Migration

C) Manual Data Entry

D) API Integration

Answer: B) Data Migration

71.Which statement is used to execute a macro in VBA?

A) Run Macro

B) Execute Macro

C) Call Macro

D) RunProgram Macro

Answer: C) Call Macro

72.Which function is used to run a macro automatically when Excel opens?

A) AutoRun

B) StartMacro

C) AutoOpen

D) RunOnOpen

Answer: C) AutoOpen

73.Which statement starts a comment line in VBA?

A) //



B) '''

C) --

D) **

Answer: B) '''

74.Which programming language is used for writing VBA code?

A. Java

B. Python

C. Visual Basic

D. C++

Answer: C) Visual Basic

75.What is a User Form in VBA?

A. A type of data validation

B. A built-in Excel function

C. A graphical interface for collecting user input

D. A type of chart

Answer: C) A graphical interface for collecting user input

76.Which function is used to display a message box in VBA?

A. MsgBox

B. ShowMessage

C. AlertBox

D. DisplayMessage

Answer: A) MsgBox

77.Which Excel feature is used for organizing and summarizing data?

A) Pivot charts

B) Formulas



C) Pivot tables

D) Data validation

Answer: C) Pivot tables

78.What does data structuring involve?

A) Cleaning data

B) Sorting data

C) Organizing data

D) Aggregating data

Answer: C) Organizing data

79.How can you add a chart title in Excel?

A. Using the Chart Elements button

B. Right-clicking on the chart and select "Add Chart Title"

C. Typing directly on the chart

D. All of the above

Answer: D. All of the above

80. What does the x-axis represent in an Excel chart?

A. Data labels

B. Chart title

C. Horizontal axis

D. Vertical axis

Answer: C. Horizontal axis

81.Which feature allows you to add interactive elements like dropdown lists to
an Excel chart?

A. Data Validation

B. Data Filters



C. Slicers

D. Sparklines

Answer: C. Slicers

82.Which Excel tool can help you analyze and interpret chart data effectively?

A. Data Tables

B. PivotTables

C. Data Analysis ToolPak

D. Scenario Manager

Answer: C. Data Analysis ToolPak

83.Which of the following is NOT a type of data visualization?

A) Bar chart

B) Line graph

C) 3D model

D) Scatter plot

Answer: C) 3D model

84.Which color scheme is NOT recommended for data visualization due to
potential readability issues?

A) Monochromatic

B) Grayscale

C) Rainbow

D) Pastel

Answer: C) Rainbow

85.How can you ensure data accuracy before creating charts?

A) Guess the data

B) Use random numbers



C) Validate and clean the data

D) Ignore errors

Answer: C) Validate and clean the data

86.What does the 'Cell Link' property of a form control indicate?

a) The cell to which the control is linked
b) The text displayed on the control
c) The font color of the control
d) The shape of the control

Answer: a) The cell to which the control is linked

87.What does VBA stand for?

A) Visual Basic Application

B) Variable Basic Algorithm

C) Visual Basic for Applications

D) Virtual Basic Automation

Answer: C) Visual Basic for Applications

88.What is the file extension for a macro-enabled Excel workbook?

A) .xls

B) .xlsx

C) .xlsm

D) .xlam

Answer: C) .xlsm

89.What does a macro-enabled workbook contain?

A) Data only

B) Macros and data

C) Formulas only

D) Charts and graphs



Answer: B) Macros and data

90.Which tool is commonly used for creating advanced visualizations with scripting
capabilities?

A) Excel

B) Tableau

C) R

D) PowerPoint

Answer: C) R

91.Which transformation allows you to filter rows based on specific criteria?

a) Remove Duplicates

b) Filter Rows

c) Group By

d) Add Custom Column

Answer: b) Filter Rows

92.Which of the following is NOT a step in the Power Query process?

a) Connection

b) Analysis

c) Transformation

d) Loading

Answer: b) Analysis

93.What is the shortcut to launch Power Query in Excel?

a) Alt + F

b) Ctrl + Q

c) Alt + Q

d) Ctrl + Shift + Q



Answer: c) Alt + Q

94.Which function would you use to combine two or more text strings?

A) CONCAT

B) AVERAGE

C) COUNT

D) MAX

Answer: A) CONCAT

95.Which function would you use to calculate the standard deviation of a range of
cells?

A) STDDEV

B) AVERAGE

C) COUNT

D) SUM

Answer: A) STDDEV

96.How can you combine multiple chart types in a single Excel chart?

A. Using the "Insert Chart" option

B. Dragging and dropping different chart types

C. Using the "Combo Chart" option

D. All of the above

Answer: C. Using the "Combo Chart" option

97.Which statement is used to end a loop in VBA?

A) Exit Loop

B) End Loop

C) Break Loop

D) Stop Loop



Answer: A) Exit Loop

98.Which method is used to convert data into a standardized format?

A) Data validation

B) Data transformation

C) Data normalization

D) Data encryption

Answer: C) Data normalization

99.What does the 'Pivot Chart' feature allow you to do?

A) Analyze data

B) Create visual summaries

C) Filter data

D) Sort data

Answer: B) Create visual summaries

100. How can you combine multiple charts into one in Excel?

A) Merge cells

B) Use the "Combine Charts" option

C) Use different worksheets

D) Drag and drop

Answer: B) Use the "Combine Charts" option








